
 
CCA-101: Fundamentals of IT & Programming. 

 

Assignment-1 

 

 

Q1. What are the four fundamental parts of computer? Explain with the help of a diagram? 

Ans: The four fundamental parts of a computer are 

 

❖ Input 

❖ Output 

❖ Processor(CPU) 

❖ Memory Unit 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Input Device: An input device is any hardware device that sends data to a computer, allowing 

you to interact it and control it. 

2. Output Devices: An output device allows data to be transmitted in a human friendly form. 

3. Processor: It is the portion of a computer that retrieves and execute instruction. 

4. Memory Unit: It is a component of a computer system. It is used to store data, instruction and 

information. 

Input device Central Processing Unit 

Control Unit 

Arithmetic/logic 

Memory Unit 

Output device 



 
Q2. Discuss about the classification of computers based on size and capacity? 

Ans: The classification of computers based on size and capacity are as follows:- 

1. Super computers:-  It is the most powerful and physically the largest by size. These are 

design to process huge amount of data. The fastest super computer can perform over one 

trillion calculations in a second. Eg:- JAGUAR, ROADRUNNER etc. 

2. Mainframe computers:- It is a very large often filling an entire room and can process 

thousands of millions of instructions per seconds. In a mainframe environment, users 

connect to the mainframe through the many terminals wired to the mainframe. They are 

capable of supporting hundreds to thousands of users simultaneously. Eg:- IBM mainframe 

Z13,IBM system z9 mainframe. 

3. Minicomputers:- They are much smaller than mainframes. These computers are also less 

expensive. Sometimes reffered to Midrange Server or Midrange Computer. They are 

typically larger, more powerful and more expensive than desktop computers. Users 

connect to the server through a network by using desktop computers. Eg:- Apple ipod, 

CDC 160A. 

Microcomputers:- They are the most frequently used type of computer. It is also known as 

personal computer(PC). A microcomputer is a small computer system designed to be used by 

one person at a time. Eg:- Desktop computers, Laptops. 

Q3. What is the meaning of computers generation? How many computer generations are defined? What 

technologies were/are used? 

Ans:-     Generation in computer terminology is a change in technology of a computer which were being     

used. 

         There are four computer generation such as 1st generation, 2nd generation, 3rd generation and 4th 

generation. 

• In the first computer system, Vacuum tubes are used. 

• Transistors are used in the second generation. 

• Integrated circuit technology were used in the third generation. 

• In the fourth generation microprocessors are used. 

Q4. Differentiate between volatile and non volatile memories? 

Ans:-      

Volatile memory Non-Volatile memory 

1. It is a computer storage that only 
maintains its data while the device is 
powered. 

2. E.g:- RAM. 
3. Primary memory has limited storage 

capacity and is volatile. 

1. It is a type of computer memory that 
has the capacity to hold saved data 
even if the power is turned off. 

2. Eg:- ROM, hard disk, floppy disk etc. 
3. Secondary memory provides 

permanent storage of data and in 
bulk quantity.   

 



 
Q5. Distinguish among system software, application software and open software on the basis of their 

features? 

Ans:- System Software:- It is a type of software that is designed to run a computer’s hardware and 

applications programs. Software like operating system, compilers, editors and drivers etc. come under 

this category. A computer cannot function without the presence of system software. 

    Application Software:-  It is a software created for specific purpose used by end users. It can be called 

an application of simply an app. 

           Example: Word processors, Accounting app etc. 

    Open Software:-  It is a type of computer in which source code is released under a licence in which the 

copyright holder grants users rights to study, change and distribute the software to anyone and for any 

purpose. 

        Example: The Linux operating system. 

Q6. a)  Create a file in MS-Word to insert a paragraph about yourself and save it with file name 

“yourself”. Describe all steps involved in it? 

Ans:-  “Yourself” 

                   My name is Chingakham Herojit Meitei. I am 22 years old. I love to dance and sing. I am a 

student of science at BIRAMANGOL COLLEGE, SAWOMBUNG,IMPHAL EAST, MANIPUR. Currently I am 

learning computer CCA course at RGI TRAINING INSTITUTE. 

The steps involved are: 

➢ We click the Microsoft office button. 

➢ We select new. The new document dialog box appears. 

➢ We select blank document under the blank and recent section. I will be highlighted by 

default. 

➢ We click create. A new blank documents appear in the word window. 

➢ To save the documents, we click again the Microsoft  office button. 

➢ We select save as      word document. The save as dialog box will appears. 

➢ We select the location where we want to save the documents using the drop down 

menu. 

➢ We enter the file “yourself” for the documents. 

➢ We click the save button. 

b). Write steps regarding followings: 

➢ To change the font style. 

➢ To change the font size. 

➢ To change the font color. 

➢ To highlight( in yellow) the line that reads “need to get IMS’s address”? 

Ans:  Steps to change the font style: 

1. We select the text we want to modify. 



 
2. Left click the drop-down arrow next to the font style box on the home tab. The font style 

drop-down menu appears. 

3. We move cursor over the various font styles. A live preview of the font will appear in the 

document. 

4. Left click the font style we want to use. The font style will change in the document. 

 

Steps to change the font size: 

1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font size box on the home tab. The font size 

drop-down menu appears. 

3. We move cursor over the various font sizes. A live preview of the font size will appear 

on the document. 

4. Left click the font size we want to use. The font size will change in the document. 

 

Steps to change the font color: 

1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font color box on the home tab. The font 

color drop-down menu appears. 

3. We move cursor over the various font colors. A live preview of the font color will 

appear on the document. 

4. Left click the font color we want to use. The font color will change in the document. 

 

Steps to highlight the line: 

1. We select the line that reads “needs to get IMS’s address”. 

2. We click the highlight command and select yellow color in the font group on the 

home tab. 

 

Q7. Create a file in MS-Word for the following document and save it with file name ‘ms-word’. Describe all 

steps involved in it? 

              MS-Word 

              MS Word is a widely used commercial word processor developed by Microsoft. 

              MS Word is application software, which is capable of  

• Creating 

• Editing 

• Saving 

• Printing any type of document  



 
Ans:                  MS-Word 

              MS Word is a widely used commercial word processor developed by Microsoft. 

              MS Word is application software, which is capable of  

• Creating 

• Editing 

• Saving 

• Printing any type of document  

 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by default. 

4. We click create. A new blank document appears in the word window. 

5. We create the given document from the question. 

6. We select the text “MS-Word” to change the font size by clicking on the font size box on the 

home tab. 

7. We select the text “MS-Word” to change the font color into red by clicking on the font color 

menu. 

8. We select the text word processor and underline it by clicking the underline command in the 

font group the home tab. 

9. We select the text “MS-Word” to change the font style into italic by clicking italic command. 

10. We select the text we want to format as a list and click on the bullets command on the home 

tab. 

11. We change the font color of the text “creating” and “saving” into blue and red resp. by clicking 

on the font color command, again we select the text “and” and click on strikethrough 

command. 

12. We select the text ” printing any type of document” and change the font style into bold by 

clicking on the font style command.  

13. We save the file name as “ms-word” by clicking the Microsoft office button and select save as. 

14. We select the location where we want to save documents using drop-down menu. 

15. We click the save button. 

 

Q8. Create a file in MS-Word for the following document and save it with file name “equation”. Describe 

all steps involved in it? 

         

 

 



 
   Equation: 

 𝑥2+𝑦5 =30 

   𝑧3+𝑞4=50 

   𝑎2+𝑏8=𝑥2+𝑦8 

Ans:           Equations 

           x2+𝑦5=30 

           𝑧3+𝑞4=50 

           𝑎2+𝑏8=𝑥2+𝑦8 

The steps are: 

1. We create the given documents in MS-Word 

2. We select the text where we want to format and click to the subscript and superscript 

command on the home tab 

3. We save the file name as “equation” by clicking the Microsoft office button and select save 

as  

4. We select the location where we want to save the document using the drop-down menu 

5. We click the save button 

 

Q9. Create a file in MS-Word that convert existing highlight text to table as shown below and save it as file 

name “texttotable”. Describe all steps involved in it. 

       Select the text you to convert. 

      Select the insert tab. 

      Click on table command. A dialog box appears. 

      Click on convert text to table, a new dialog box appears here set number of columns. 

      Click on OK finally selected text convert in a table. 

 

 

Select the text convert you want to. Select the insert tab. 

Click on table command. A dialog box appears. Click on convert text to table, a new dialog box 
appears. 

Here set of columns. Click on OK finally selected text convert in a table 

 

 



 
Ans:     To convert existing text to table: 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab 

3. We click the table command 

4. We select convert text to table from the menu. A dialog box appears 

5. We select ok. Then the text appears in a table. 

 

Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it? 

Ans:  

  

          

          

          

          

          

          

          

 

The steps are: 

1. We place our inserting point in the document where we want our table to appear  

2. We select the insert tab 

3. We click the table command  

4. We drag our mouse over the diagram squares to select the numbers of columns and rows in 

the table. 

5. Left click our mouse and the table appears in the document. 

6. We enter the text into the table. 

 

 

 

 

 

 

 

 

 



 
Q11. Create a following worksheet in MS-excel and save it with name ‘book1’? 

                   Roll No.                 Name                Marks 

                                               1 n 1                      60 

                                                2 n 2                     70 

                                                3 n 3                      80 

                                                4 n 4                      90 

                                                5 n 5                      40 

                                                6 n 6                       50 

                                                7 n 7                       77 

                                                8 n 8                       44 

                                               9 n 9                        88 

                                             10 n 10                     55 

                                               Sum                       654 

                                           Average                     65.4 

                                           Maximum                  90 

                                           Minimum                   40 

Ans: 

 

 

Q12. Calculate the following things of a range (c2:c11) of data in the worksheet created in question no. 

10. 

-  The sum of the marks using AutoSum in a range of cells (c2:c11) 

- Average of the marks in a range of cells (c2:c11) 

- Highest marks in a range of cells (c2:c11) 

- Minimum marks in a range of cells(c2:c11) 

 

                   Roll No.                 Name                Marks 

                                               1 n 1                      60 

                                                2 n 2                     70 

                                                3 n 3                      80 

                                                4 n 4                      90 

                                                5 n 5                      40 

                                                6 n 6                       50 

                                                7 n 7                       77 

                                                8 n 8                       44 

                                               9 n 9                        88 

                                             10 n 10                     55 

                                               Sum                       654 

                                           Average                     65.4 

                                           Maximum                  90 

                                           Minimum                   40 

Ans: 

 

 

 



 
Q13. a) Describe various steps involved in the following 

- To modify column width of a worksheet 

- To modify the row height of a worksheet 

- To delete rows and columns of a worksheet 

 

Ans:    - To modify column width with a worksheet: 

I. Select a column or a range of columns. 

II. Select a Home tab and in the cells group, select format. 

III. Click on column width and type the width for column. 

IV. Select ok. 

- To modify the row height of a worksheet. 

I. Select a row or a range of rows  

II. Select a Home tab and in it the cells group, select a format  

III. Click on row height and type the height for row 

IV. Select OK. 

- To delete rows and columns of a worksheet. 

I. Select the cell you want to delete within the column or row. 

II. Select Home tab. And in cells group click on delete sheet column or row. 

                                           OR 

III. Select the desire row or column. 

Q13. b)  Describe following terms in the worksheet. 

- Absolute reference and relative reference in formula  

- Cells Address 

Ans:   

- Absolute Reference: 

An absolute reference in Excel means there is a fixed point of reference applied to a cell or a 

formula. This is so the return value will always stay the same no matter where the cell or formula 

moves to – within the same sheet or across different sheet. 

 

This refers to a fixed point of reference is a constant, and involves the use of dollar sign € in the 

formula (i.e., everyone is to receive the same bonus payout, so the amount €1500 is constant in 

this situation. 

 

- Relative Reference; 

It is the default cell reference in Excel. It is simply the combination of column name and row 

number without any dollar € sign. When you copy the formula from one cell to another the relative 

cell address changes depending on the relative position of column and row. C1,D2,E4, etc. are 

examples of relative cell references. Relative references are used when we want to perform a 

similar operation on multiple cells and the formula must change according to the relative address 

of column and row. 

 

This refers to a relative point of reference is constantly changing and dollar sign (€) is absent in the 

formula (i.e., when each unit price and quantity are difference variables, there’s no constant in the 

calculation). 

- Cell Address 



 
 A cell address is combination of column letter and a row number that identifies a cell on a worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1;B2 refers to the second 

cell in column B, so on. 

         When used in formula, cell references help Excel find the values the formula should calculate. For 

instance, 

         To pull the value of A1 to another cell, you use this simple formula: 

           =A1 

         To add up the value in cells A1 and A2, you use this one: 

          =A1+A2 

 

Q14. a)  What tools are available to customize our PowerPoint presentation? 

Ans:  

        Tools available to customize our PowerPoint presentation are: 

a) Perspector 

b) Pivot viewer  

c) Autodesk 3D Max 

d) VisualBee PowerPoint Add-in 

e) SmartArt 

f) Animation and Transition 

g) Wordle 

h) CA coo 

i) Oomfo 

j) Clip champ 

b) Write the steps for the following action for the creation of power point presentation  

     -  Open a blank presentation 

     -  Save the presentation as Lab1.pptx 

     -  Add a title to the first side: the name of your college 

     -  Type your first name and last name in the subtitle section 

     -  Add new slide which has a Title and Content 

Ans:  

- To open a blank presentation 

I. Open Powerpoint presentation using ‘Run’ command (Window Key + R). 

II. Select the ‘Blank Presentation’. It is opened  

-  Save the presentation on Lab1.pptx 

i. Select the ‘File’ on Tab bar 

ii. Click on ‘Save As’ option 

iii. Click on document/Desktop as your choice. 

iv. Type the name ‘Lab1.pptx’ 

v. Click the ‘Save’ button 

- Add a Title to the first slide: the name of your college. 

i. Left click on the ‘Click to Add Title’ section on the first slide. 

ii. Type the name of your college  

- Type your first name and last name in the subtitle section 

i. Left click on the ‘Click to Add Subtitle’ section. 

ii. Type your first name and last name. 



 
- Add a New Slide which has a title and content. 

i. Select the Home tab. 

ii. Click on the dropdown button of the ‘New Slide’ on toolbar 

iii. Select the slide having ‘Title and Content’. It is added. 

 

Q15. Write steps for creation of a set of PowerPoint slides that demonstrate your skill to use the tools of 

PowerPoint. It should include the following things 

➢ Titles slide & bullet list 

➢ Inserting Excel Sheet 

➢ Clip Art and Text 

➢ Slide show effect 

Ans:  

➢ Title slide and bullet list: 

i. Open PowerPoint presentation 

ii. Select the Home tab 

iii. Click at the dropdown button on ‘New Slide’ at toolbar  

iv. Select the slide having Title slide and bullet list 

➢ Inserting Excel Sheet: 

i. Open the slide where you want to insert the Excel Sheet 

ii. Select the ‘Insert Tab’. And click on ‘Object’ on tool bar 

iii. Select the ‘Microsoft Excel Worksheet’ object type 

iv. Click the ‘Ok’ button. 

➢ Clip Art and Text: 

i. Select the Inset Tab. 

ii. Select the ‘Picture’ or ‘Online picture’ on tool bar 

iii. Choose the appropriate art for the topic 

iv. Click on the ‘Insert’ button 

➢ Slide show effects: 

i. Select ‘Design Tab’ for Themes, variants and slide size. 

ii. Select ‘Transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, etc. 

for slide effects. 

 

Q16. What is the difference between Machine language and High Level languages? 

Ans:    

        

Machine Languages High Level Languages 

1. A computer programming languages 
consisting of binary instruction which a 
computer can respond to directly. 

2. It requires no translator to translate the 
code. It is directly understood by the 
computer. 

3. This languages makes fast and efficient 
use of the computer. 

1.  It is programming languages that enables 
development of a program in a much more 
user friendly programming context. 

2. It takes additional translation time to 
translate the source code to machine code. 

3. They are programmer friendly. 



 
Q17. Discuss about data type of C programming Languages? 

Ans: The different data type of C programming Languages are: 

       Char: the most basic data type in C. It store a single character and requires a single bite of memory in 

almost all compilers. 

      Int: as the name suggest, and int variable is used to store an integer  

      Float: it is used to store decimal numbers. 

      Double: it is used to store decimal numbers (number with floating point value but its range of value is        

high in comparison to both). 

 

Q18. Find the output of the following expressions? 

a) X=20/5*2+30-5     b) y=30-(40/10+6)+10    c) z=40*2/10-2+10 

Ans:  a) x=33 

b) Y=30 

c) Z=16 

 

Q19. Describe the syntax of the following statements? 

a) If – else statement    b) for loop   c) while loop d) do – while loop 

Ans:   

a) If – else statement: 

 

If statement can be followed by an optional else block of statements, which execute when the 

Bootcan expression is false 

 

   Syntax  

    

   If (expression) 

 

   { 

 

   True block of statements; 

 

   } 

      

b) For loop is similar to white loop. Basic syntax of for loop is as follows: 

 

For (expression 1; expression 2; expression 3) 

 

{ 

 

Block of statement 

 

} 

 

In the above syntax 

 



 
Expression1- initializes variables 

Expression2 – conditional expression as long as this condition is true, loop will keep executing. 

 

c) While loop  

 

   Basic syntax of white loop is as follows 

 

         White (condition) 

                         Single statement 

      

       OR while (condition) 

 

      { 

 

      Block of statements 

 

      } 

   

d) Do – while loop 

 

Do – while loop is just like a while loop expert that the text condition is checked at the end of 

the loop rather than the start. This has the effect that the body of the loop are always executed 

at the least once 

 

Basic syntax of do – while loop is as follows 

 

Do 

 

{  

 

Single statement 

           OR 

Block of statements 

 

} while (condition) 

 

 

 

 

 

 

 

 

 

 



 
Q20. Find the output of the following program segments? 

a) b) c) 

#Include<stdio.h> 
Int main() 
{ 
    Int 1; 
      For (i=1;i<2;i++) 
       { 
       Printf(“MS Ghaziabad\n”) 
       } 
} 

#include<stdio.h> 
Int main() 
{ 
     Int i=1; 
     While (1<=2) 
} 
    Printf(“MS Ghaziabad\n”) 
    } 
} 

#include<stdio.h> 
Void main() 
{ 
   Int a=10, b=100; 
   If(a>b) 
   Printf(“Largest number is %d\n”,a) 
              Else 
   Printf(“Largest number is 5d\n”,b) 
} 
 

 

 

 

Ans: 

a) IMS Ghaziabad 

b) IMS Ghaziabad 

c) B=100 


